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Introduction to Taming Your Email with Thunderbird 3.1

Introduction to Taming Your Email with Thunderbird 3.1
This document is a guide written for the Ubuntu Vancouver Local Community, or Ubuntu Vancouver 
LoCo (UVLC), on how to manage the ever-growing amount of email we get today using Mozilla 
Thunderbird 3.1. It is the companion guide to Getting Started with Thunderbird 3.1, a quick-start guide to 
installing Thunderbird and importing your existing email messages and contacts. 

This guide assumes that you have Thunderbird installed and just covers the more advanced topics related 
to managing a heavy email load. If you would like to get some help with installing Thunderbird and 
importing your email messages and contacts, please check out the Getting Started with Thunderbird 3.1 
guide on the Ubuntu Vancouver LoCo website. The Ubuntu Vancouver LoCo is an Ubuntu users group 
for Vancouver, Canada, and is a great place for learning about, and sharing your passion for all things 
Ubuntu. The Getting Started with Thunderbird 3.1 guide can be found on the UVLC website under 
Discussions > Message Board > Technical Support:

http://www.meetup.com/ubuntuvancouver/messages/boards/forum/1245793  

This guide will follow an Ubuntu user, named Mary, who wants to use Thunderbird to manage the unruly 
forest of email that has sprung up in her email accounts. After explaining what everything is called in 
Thunderbird, we'll start off accompanying Mary as she learns how to use Thunderbird’s advanced tools to 
view and search for email messages. Next, Mary will learn how to sort, filter, mark and tag her email 
messages so that she can see at a glance the ones that are important to her. Finally, we will see how Mary 
maintains Thunderbird by deleting and archiving old email messages, compacting folders to keep them 
working smoothly, and backing up her settings and email. 

Because nothing stays the same, least of all computer programs, there are sure to be changes to future 
versions of Thunderbird that are not reflected in this document. That is where you come in. If you find 
that things “just don't seem right”, it could be because this guide was written for an earlier version of 
Thunderbird than you have. Please feel free to ask for help, or mention the changes, on the Ubuntu 
Vancouver LoCo discussion boards. Your assistance will help us keep this guide up to date. After all, 
helping each other is the spirit that makes Ubuntu great! 

http://www.meetup.com/ubuntuvancouver/  
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Taming Your Email with Mozilla Thunderbird 3.1
“I have just too much email!”

“Are you sure you sent it to me? I don't see it.”

“Arrgh!!”

Ever use any of these statements when dealing with your email? Is your 
Inbox starting to feel like a dark and forbidding jungle? It is time to tame 
the wilderness with Mozilla Thunderbird 3.1. 

By default, Ubuntu 10.10 comes with the Evolution groupware client, but 
not all users need, or want it, for their email messaging. Enter 
Thunderbird. Thunderbird is a free email client produced by Mozilla, the 
same folks that make Firefox. It has been around for years, but with the 
release of version 3.1 and some great new features, Thunderbird is even 
better than ever.

1 Introducing Mary, an Email User Under Siege
Mary is an email user with a problem. She has three email accounts, each with 
hundreds of email messages, and every day Mary receives dozens of new 
messages. She is suffering from 'email overload'! Mary tries to keep up to the 
barrage of email, but checking multiple email accounts for new mail, and then 
deciding what is important and what isn't, seems to take all her time. Unlike 
'snail mail', email may save trees, but the forest has sprung up in her Inbox.

Mary needs help!

1.1 Why does Mary want to use Thunderbird
Ubuntu comes with a perfectly good email client installed by default; Evolution. If you don't want to use 
Evolution, there are also many free webmail services. So why does Mary want to use Thunderbird? Here 
are a few reasons:

• Evolution is a groupware client that deals with not just email, but also calendars, to-do lists and 
notes. Evolution will also connect to the email systems that many business run for internal email. 
Frankly, that is way more than Mary needs. All she is looking for is a program that manages her 
Internet email.

• Thunderbird is a commonly used email client on all the major computer operating systems, like 
Linux, Macintosh and Windows. Once Mary is familiar with Ubuntu Thunderbird, she can use it 
on any computer, even the Windows computer her boss forces her to use!

• There is a huge community of Thunderbird users and developers. With so many people using 
Thunderbird, when Mary needs help, there is sure to be someone who can answer her questions. 
She can also chose from thousands of free additions to Thunderbird that extend its functionality.

• Webmail services leave you at the mercy of the service provider. They can make changes to their 
service at any time, or even discontinue it.
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• The features of webmail services are generally quite limited. Mary prefers the vast number of 
features that she gets with Thunderbird.

• Mozilla Thunderbird is developed right here in Vancouver, so not only is Mary supporting a local 
product, but the Ubuntu Vancouver Local Community can help shape future versions.

1.2 Using this guide
If you don't want to read through all the introductory material, and want to jump right to the section that 
interests you, you can use this map of the Email Forest to help find your way. Clicking on a label will 
take you to the section that covers the topic. Remember, you are never lost if you have a map!

Follow Mary as she cleans up her email clutter 

To help you make most of Thunderbird, we will follow Mary as she learns how to use it to manage 
her email clutter. Mary will take the tangled forest of email messages and accounts, learn how to 
more efficiently view and search them, organize and prioritize them, and then thin them out by 
archiving and deleting them. Once she has a handle on all that, Mary will find out how to protect 
herself from disaster by maintaining her folders and by backing up Thunderbird.
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Introducing Mary, an Email User Under Siege

Become a power user with tips and tricks

As Mary learns how to use Thunderbird, she picks up tips and tricks that make her 
work even more efficient. As she finds these hidden gems, she writes them down on 
sticky notes that you can see stuck to these pages. Using these can make a power 
user out of anyone, and help you to avoid potential problems. 

Document conventions

While you work your way through this guide, there are a few document conventions that will help 
you along. By recognizing these conventions, you will be able to see at a glance which items are 
Thunderbird or Ubuntu components, terms that are defined in the Glossary, links to other parts of the 
guide, and hyperlinks to Web pages.

Convention Description Example

Bold Indicates a Thunderbird/Ubuntu 
component or menu item. Often, 
Thunderbird components are also 
defined in the Glossary.

In the Address Book, click File, point to 
New and click Address Book Contact.

Italic Indicates the word is defined in the 
Glossary. The first instance in each 
chapter of words defined in the 
Glossary are in italics.

Click the second drop-down list and select 
how you want to match the search criteria.

Italic-bold Indicates words that should be 
typed.

Type thunderbird into the search box.

Italic-underline Indicates a link to another section in 
the guide. A page number is also 
included. Clicking on the link will 
take you to the page.

For more information, see, “Grouping 
email folders with Unified Folders” on 
page 8.

Blue-underline Indicates links to Web sites. http://www.meetup.com/ubuntuvancouver/

Getting further help

If you need more help setting up and using Thunderbird, the best 
source of information is the Mozilla Messaging support Web site:

http://support.mozillamessaging.com
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Tip!
Can't find it on the Mozilla 
support Web site?

Try the Tech Support 
Discussion on the Vancouver 
Ubuntu LoCo site, or at 
Launchpad.
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2 Finding Your Way Around the Thunderbird Interface
Before we start following Mary in her quest to tame her email, we should probably take a 
look at what the various parts of the Thunderbird interface are called. Calling things, “the 
get mail or filter thingies”, might be fine for Mary, but will get awfully confusing if you 
don't know what she is referring to.

Here are the common names for the Thunderbird interface components so that we are all on 
the same page while we accompany Mary on her journey.

2.1 Main Thunderbird window

2.2 Message List Pane
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Figure 2: Message List Pane

Figure 1: Main Thunderbird window
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2.3 Message Pane

2.4 Address Book
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Figure 4: Address Book
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3 Viewing and Searching Your Email Messages
The first thing that Mary must do to organize her overgrown email accounts is to learn 
how to view messages more efficiently and search for the ones she needs. 
Thunderbird has many features that Mary can use to make viewing and searching her 
email messages easier than ever... and she doesn't need to be a detective to use them!

3.1 Viewing your email messages

Viewing email messages in a conversation

Mary often has long email exchanges that include dozens of replies going back and forth. 
Thunderbird calls these exchanges a conversation or thread. Sometimes, Mary needs to look up 
things that were said in earlier email messages. Sure, she could scroll through the latest message, but 
it might not include all the quoted text. She could also do a search to find the message that contained 
the information, but Mary has found a better way!

If Mary uses the Thunderbird Open in Conversation feature, the email is opened in a new tab 
containing a Message Pane and a Message List Pane. The Message List Pane includes only email 
messages in that conversation, displayed in a threaded format. Now Mary can view all the email 
messages in that conversation in one place.

To open an email conversation thread in a tab

• Right-click on the email message in the Message List Pane and then click Open 
Message in Conversation.
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Tip!
To group messages in threads 
in the normal Message List 
Pane, click the thread column 
header.

Figure 5: Email message open in a conversation tab

Figure 6: Open Message in Conversation
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• Select the email message and then click Open in Conversation on the Message menu.

• On the other actions drop-down list, located on the Message Header, click Open in 
Conversation.

Grouping email folders with Unified Folders

By default, Thunderbird groups email folders in the Folder Pane by 
email account, or the All Folders view. Each email account is 
displayed in the Folder Pane with the Inbox, Sent, Trash, Junk and 
any user-created folders listed under it. Mary has found that this 
folder structure can become quite unwieldy when she has multiple 
email accounts containing many folders. Her Inboxes are spread all 
over the place and she has to click in each one to view her email 
messages. Thunderbird 3.1 has a new feature called the Unified 
Folders view that makes viewing folders much easier.

Unified Folders group similar folders together, instead of grouping 
them by account. There is a group called Inbox that has the Inboxes 
for all of Mary's accounts listed under it. The same is true for the 
Drafts, Sent, Junk and Trash folders. By displaying Unified Folders, 
Mary can see all of her Inboxes in one place, and best of all, she can 
click on the parent Inbox folder to see the messages in all the Inbox 
subfolders at one time! She can still view the email messages for a 
single account by clicking on a subfolder under the Unified Folders 
Inbox.
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Figure 7: Message menu

Figure 8: other actions drop-down list

Figure 9: All Folders

Figure 10: Unified Folders
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Mary can use the arrows at the top of the Folder Pane to cycle through folder views. The views she 
can display are: All Folders, Unified Folders, Recent Folders, Favorite Folders and Unread 
Folders.

3.2 Finding email messages with Thunderbird's search tools
There are times that Mary wants to find email messages that refer to specific things, or are from certain 
people. With hundreds of email messages in each of her three email accounts, looking through them and 
finding what she wants can be a day-long task. Fortunately, Thunderbird has some very useful search 
tools.

Searching using the Global Search

The easiest method that Mary can use to search her email messages is the Global Search box on the 
right-hand side of toolbar. The Global Search will search all of Mary's email messages except for 
those in the Junk and Trash folders. It will also search all the email message fields, such as the 
sender, the recipient, the subject, and the message body. This search is not case-sensitive so Mary 
does not have to worry about capitalization.

While Mary is typing in the Global Search box, a drop-down list displays possible matches to email 
addresses, or she can press ENTER to search for both email addresses and words in the body or 
subject of the messages. Please note that the search will only match complete words, not partial 
words. It will, however, find the plural or singular versions of words.
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Figure 12: Global Search drop-down list

Tip!
The Favorite Folders view 
displays only the folders you 
want to see in the Folder 
pane.

You can add folders to the 
Favorite Folders view by 
right-clicking on the folder 
and selecting Favorite Folder. 

Figure 11: Unified Folders and adding a Favorite Folder
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The search results that match Mary's search term are previewed in a new tab. Clicking on a search 
result will open the email message in a conversation tab that displays the message any other related 
messages, if it is part of a thread.

Searching for multiple terms using the Global Search

So now Mary can quickly search for email messages or addresses that contain a word, but sometimes 
she needs to search for multiple words. For instance, she seems to get more “Virus Alert” email 
messages from well-intentioned Windows users than messages from her friends. Mary remembers 
that her friend, Oliver, sent her an email message about viruses and wants to find it again. OK, she'll 
type viruses into the Global Search box and find what he was referring to.

Hmm, that wasn't such a good idea! Wow, are there really that many Windows viruses out there? 
Mary once again applauds her choice to run Ubuntu. Problem is, the search results seem to go on for 
ages! Time to try to narrow the results down by using multiple search terms.

Searching for email messaged containing all the search terms

To search for email messages that contain all the search terms, Mary simply needs to type them 
all into the Global Search box and press ENTER.

Mary types oliver viruses into the Global Search box and the multitude of email messages 
containing the word “viruses” is reduced to the single one she was looking for.
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Figure 13: Global Search results tab

Figure 14: Global Search with multiple terms
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Searching for email messages containing a phrase

What if Mary doesn't remember who sent her the email message, but remembers a phrase used 
in the message? That could narrow the search down. She thinks that the message contained the 
phrase “contains viruses” so she types “contains viruses” (with the quotation marks) into the 
Global Search box, and sure enough, the search finds the email message she was looking for.

Enclosing words within quotations matches the exact phrase instead of individual words. You 
can also combine individual search terms and phrases in one search. For instance, to find 
messages containing word ”oliver” and the phrase “contains viruses”, type: oliver “contains 
viruses”

Filtering and analyzing Global Search results

There are times that Mary has searches that return dozens of matching email messages, even using 
multiple search terms or phrases. When this happens, Mary needs a way of thinning the forest of 
results down to something more manageable. Fortunately, the Thunderbird Global Search results 
tab allows her to do this. She can filter the results and analyze them by date.

Filtering Global Search results

The Filters options are displayed on the left-hand side of the Global Search results tab. They 
allow Mary to filter the results based on whether they are from her or to her, their status, if they 
have attachments, the folder they are in, the email account they are in, or their email addresses. 
By clicking on an item in the Filter options, Mary can select if the messages match the item, or 
do not match the item. Clicking the filter item again lets Mary remove the filter.

11

Figure 15: Global Search with a term and a phrase

Figure 16: Global Search Filters
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Analyzing Global Search results by date

The top of Global Search results tab shows a graph of how many 
email messages are found based on their date. It's all well and fine 
for Mary to find all email messages from info@meetup.com that 
ask for an RSVP, but she isn't interested in those for past events. 
By hovering her mouse over a Filters option, the days that have 
messages matching the option are highlighted on the graph.

Mary can also click a date on the graph to only display email 
message results for that day.

Advanced searches using the Search Messages tool

Thunderbird allows Mary to do advanced searches that find email 
messages that contain, or do not contain, complex combinations of 
various terms, addresses, or attributes. Each thing searched for is 
called a Search Rule. For instance, Mary sometime forgets to RSVP to 
Ubuntu Vancouver Loco event announcements, but using the Search 
Messages tool, she can find and reply to upcoming event notices she 
missed reading. To to this, she creates set of rules that searches for 
email messages from “info@meetup.com” that contain the word 
“RSVP” but not the word “reminder” in the body, that have not been 
replied to, and that are not older than seven days. 

Now Mary never has to miss RSVP'ing to another event notice again!

To search using the Search Messages tool

1. On the Edit menu, point to Find and then click Search Messages.

2. Chose where you want to search in the Search for messages in drop-down list.

3. Select Search subfolders, Run search on server (IMAP 
only), and how you want to match the Search Rules.
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Tip!
To display more results on the 
page, you can hide the date 
graph by clicking the graph icon 
in the top right of the results 
tab.

Tip!
Unlike the Global Search, the 
Search Messages tool can only 
search a single folder and its 
subfolders at a time. To 
search all of your email 
accounts, it must be run 
separately on each. 

Figure 17: Search for messages drop-down list

Figure 18: Search Messages options

Tip!
• Match all of the following 
finds messages that match all 
the Search Rules.

• Match any of the following 
finds messages that match at 
least one Search Rule.
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4. Click the first drop-down list and select which part of the email messages to search in.

5. Click the second drop-down list and select how you want to match the search criteria.

6. Type the search criteria in the text box or select it from the drop-down list, depending on 
what is being searched for.

7. Click the plus sign to add more Search Rules.

8. Click the Search button to begin the search.
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Figure 20: Search Rule

Tip!
You can save the search for 
later use by clicking on the 
Save as Search Folder button 
at the bottom. For more 
information on saving searches, 
see the next section, “Creating
a Saved Search folder”

Figure 19: Search Rule

Figure 21: Search Rule

Figure 22: Search Rule

Figure 23: Search Messages
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Creating a Saved Search folder

Mary has now been using the Global Search and Search Messages tools for a while, but she finds 
that she often repeats the same searches. There has to be a better way, and indeed there is; Saved 
Search folders! A Saved Search is a search that continuously runs in the background, collecting 
matching email messages and placing them in their own folder.

For instance, in the last section, we saw Mary create a search for meetup.com event notices that she 
hasn't RSVP'd to yet. However, Mary would like to keep running the search on a regular basis as 
these messages sometimes get lost in the daily avalanche of new messages she receives. With a 
Saved Search, these messages are automatically collected in a folder called Missed RSVPs.

To create a new Saved Search folder

1. On the File menu, point to New and then click Saved Search.

• Note: If you are displaying Unified Folders, you need to have a subfolder of the 
parent Unified Folder selected. For more information about Unified Folders, see 
“Grouping email folders with Unified Folders” on page 8.

2. Type a name for the new Saved Search folder and choose the parent folder to put it in.

3. Click Choose and select which folders you want to search.
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Figure 25: New Saved Search Folder name and location

Tip!
A Saved Search is an easy way 
to search specific folders in 
multiple email accounts. Just 
create a Saved Search folder 
and delete it when you are 
finished.

Figure 26: Select Folder(s)

Figure 24: Unified Folders
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4. Select Search Online to search on IMAP email servers.

5. Choose how to match the rules, or to match all messages.

6. Click the first drop-down list and select which part of the email messages to search in.

7. Click the second drop-down list and select how you want to match the search criteria.

8. Type the search criteria in the text box or select it from the drop-down list, depending on 
what is being searched for.

9. Click the plus sign to add more search rules.

Clicking OK creates a folder that is constantly updated with messages matching the search.
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Figure 32: New Saved Search Folder rule

Figure 30: New Saved Search Folder rule

Figure 28: New Saved Search Folder options

Figure 27: New Saved Search Folder options

Figure 29: New Saved Search Folder rule

Figure 31: New Saved Search Folder rule

Tip!
• Match all of the following 
finds messages that match all 
the Search Rules.

• Match any of the following 
finds messages that match at 
least one Search Rule.

• Match all messages finds all 
messages, even if there are 
no matches to Search Rules.
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Searching the Junk and Trash folders

Mary recently received a phone call from Fagin Enterprises asking her why she hasn't been 
answering any of their email messages. As far as Mary knew, she hasn't received any messages from 
Fagin Enterprises. Unfortunately, it turns out that she had created a Message Filter that set the status 
of all messages with “limited time offer” in the body of the message to Junk, and Fagin Enterprises 
uses that phrase in all of their email messages.

Mary could open the Junk folder and sort by sender, but if she wants to see if there are any other 
messages using the same phrase that were mistakenly flagged as spam, a Global Search wouldn't 
work. The Global Search does not search the Junk or Trash folders. She could also run a Search 
Messages query, but that will only search a single account at a time. Instead, to search the Junk and 
Trash folders for all of her accounts, all Mary has to do is create a Saved Search folder and select 
the Junk and Trash folders in the Select Folders dialog box. For more information about Saved 
Searches see “Creating a Saved Search folder” on page 14.

3.3 Finding email messages using the Quick Filter
A quick way that Mary can search for email messages in the current folder is to use the Quick Filter to 
create view filters. A Quick Filter is a convenient way to show only email messages in a folder that 
match a set of criteria. It doesn't do anything to the messages, just hides the other email messages in the 
folder so that you only see the ones you want to. Quick Filters shouldn't be confused with email 
Message Filters that actually do things to email messages. Message Filters will be discussed in 
“Filtering email messages” on page 39. Mary most often uses Quick Filters to quickly find only unread 
or Starred messages in a folder.

The Quick Filter toolbar is located at the top of the Message List Pane. Clicking the magnifying glass 
icon above the toolbar will hide the tools if you want additional room in the Message List Pane, or if you 
don't regularly use the Quick Filter.

This tool can filter the list of messages displayed in the folder based on:

• If they are Unread Messages.

• If they are Starred Messages.

◦ You can assign Stars to email messages as visual reminders or to tell Thunderbird that they 
are important. For more information about Stars, see “Using Stars to mark important email
messages” on page 32.

• If they are from Contacts in your Address Book.

• If they have Tags.

◦ You can assign Tags to email messages to categorize and display them with different colours 
in the Message List Pane. For more information about Tags, see “Tagging email messages to
categorize them” on page 34.
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Figure 33: Quick Filter bar
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• If they have Attachments.

• Who the Sender is.

• Who the Recipients are.

• What the Subject contains.

• Words in the message body.

Using the Quick Filter

To quickly toggle a predefined filter on or off, all Mary has to do is click one or more of the Quick 
Filter icons:

      Unread Messages,      Starred Messages,      Contacts,      Tags, or      Attachments icons. 

She can further filter the results, or filter the entire message list, by typing into the Quick Filter box 
and selecting one or more of the filter options; Sender, Recipients, Subject, or Body.

If your filter doesn't match any email messages in the current folder, 
you are given the option of converting the filter to a Global Search that searches all of your folders. 
For more information about the Global Search, see “Searching using the Global Search” on page 9.

3.4 Finding email messages with the Mail Views list
Thunderbird has another view filter tool that is not displayed by default. It is the Mail Views list that you 
can add to the toolbar. Mary is thankful that she found this tool, as it not only allows her to filter her 
message views using the normal view filters discussed earlier, but it gives her more control over the 
filtering. She can even create Custom Message Views based on complex view filters and save them as 
folders.
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Figure 34: Quick Filter bar search

Tip!
To keep the filter active when 
changing folders, click the 
thumbtack on the left side of 
the Quick Filter toolbar.

Figure 35: Converting a failed Quick Filter to a Global Search
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To add the Mail Views list to the toolbar

1. Right-click on the Thunderbird toolbar and select Customize.

2. Drag the Mail Views list to where you want it on the Thunderbird toolbar.

3. Click Done to add the Mail Views drop-down list to the toolbar.

Using the Mail Views list

By clicking on the View button, Mary can quickly change how the email messages are displayed in 
the Message List Pane. She can:

• Display all her email messages.

• Display only unread email messages.

• Display email messages with specific Tags.

• Display email messages based on Custom Message Views using a set of view filters.

• To see how to create Custom Message Views, see “To add a new Custom Message View” on 
the next page.
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Figure 36: Customize the Thunderbird toolbar

Figure 37: Add Mail Views list

Figure 38: Mail Views list
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• Save the current view as a folder.

• This creates a Saved Search folder based on the view filter. To see how to save the view as a 
Saved Search folder, see “Save a View as a Folder” on page 21.

• Add or remove views from the Custom Views menu.

The most useful features of the Mail Views list are the ability to create Custom Message Views and 
to save the current view as a new folder. If you get as many email messages as Mary does, it is nice 
to be able to filter the scores of email messages clogging up your Inboxes down to something more 
manageable. This is where the Custom Message Views comes in handy. The Custom Message 
Views uses the same rule-based search criteria as the Search Messages tool, making it an extremely 
powerful method of creating view filters. For more information about the Search Messages tool, see 
“Advanced searches using the Search Messages tool” on page 12.

There are five Custom Message Views that Thunderbird has already configured for you:

• People I Know

◦ Email from contacts in your Address Book.

• Recent Mail

◦ Email messages that are less than one day old.

• Last 5 Days

◦ Email messages that are less than five days old.

• Not Junk

◦ Email messages that are not marked as Junk.

• Has Attachments

◦ Email messages that have file attachments.

To add a new Custom Message View

1. On the Mail Views drop-down list, select Customize.
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Figure 39: Mail Views menu

Figure 40: Custom Views

Figure 41: Customize Mail Views
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2. Click the New button on the Customize Message Views dialog box.

3. Type a name for the Custom Message View.

4. Select how you want to match the Search Rules.

5. Click the first drop-down list and select which part of the email messages to search in.

6. Click the second drop-down list and select how you want to match the search criteria.

7. Type the search criteria in the text box or select it from the drop-down list, depending on 
what is being searched for.
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Figure 42: Customize Message Views

Figure 43: Message View Setup

Figure 44: Message View Setup options

Figure 45: Message View Setup rule

Figure 46: Message View Setup rule

Figure 47: Message View Setup rule

Tip!
• Match all of the following 
finds messages that match all 
of the Search Rules.

• Match any of the following 
finds messages that match at 
least one Search Rule.
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8. Click the plus sign to add more Search Rules.

Clicking OK will create the new Custom Message View and add it to the Custom Views 
submenu of the Mail Views drop-down list.

You can also modify or delete Custom Message Views by selecting them from the list in the 
Customize dialog box of the Mail View drop-down list and clicking Edit or Delete.

Save a View as a Folder

The Save View as a Folder item on the Mail Views drop-down list lets 
you save the view as a folder that is continually updated. If you read the 
section about “Creating a Saved Search folder” on page 14, this might 
sound familiar. That's because all this does is save the current Mail View 
as a Saved Search folder. The search rules are filled in and the folder 
has been given a default name and location, but you can change these. 
Click OK and the Mail View is saved as a new Saved Search folder.

21

Figure 52: Save View as a Folder

Figure 48: Message View Setup rule

Figure 50: Custom Message Views

Figure 49: Custom Message Views

Figure 51: Mail Views
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4 Organizing and Prioritizing Your Email Messages
So, Mary can now efficiently search for and view her email messages. 
Unfortunately, the email jungle is still growing up around her and holding her 
back from effectively managing her email load. Mary needs to organize and 
prioritize her email messages so that she can respond in a timely manner to the 
important ones, and put off or ignore those that aren't.

As Mary tackles the task of organizing and prioritizing her email messages, she 
learns how to:

• Sort and group email messages.

• Mark and Tag email messages.

• Filter and run Junk Mail Controls on email messages.

4.1 Sorting and grouping email messages
Sorting and grouping her email messages is the first task Mary undertakes in her quest to organize and 
prioritize her email. With so many new email message coming in each day, it is important for Mary to sort 
her messages in a meaningful way, and to group them so that she can quickly find the important ones. 
More importantly, sorting and grouping her email messages helps Mary decide which ones she needs to 
deal with sooner, rather than later.

You can sort the list of messages by most of the columns that can be displayed in the Message List Pane. 
By default, the Thread, Star, Attachments, Subject, Read, Junk, From and Date columns are shown.

Message List Pane columns

Column Name Description

Thread Indicates email messages that are part of a conversation (thread) when they 
are grouped by Thread

Starred Messages that have a Star applied to them. You can assign Stars to email 
messages as visual reminders or to tell Thunderbird that they are important. 
For more information about Stars, see “Using Stars to mark important email
messages” on page 32. 

Attachments Email message that have attachments.

Subject The subject line of email messages.

Read Unread email messages have a green dot in this column

From The sender of email messages.

Junk Status Email messages marked as junk mail have a flame icon in this column. For 
more information about marking messages as junk mail, see “Using the Junk
Mail Controls” on page 50.
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Message List Pane columns (continued)

Column Name Description

Recipient The recipient of email messages. This is useful when sorting messages in 
your Sent folders.

Date The date and time email messages were sent.

Received The date and time email messages were received by your email provider.

Status Indicates if email messages have been read, are new, have been replied to, or 
have been forwarded.

Size The size of email messages. You can use this to sort messages based on how 
large an email message and its attachments are.

Tags The Tags assigned to email messages. You can assign Tags to email messages 
to categorize and display with them different colours in the Message List 
Pane. For more information about Tags, see “Tagging email messages to
categorize them” on page 34.

Account What email account the messages are in.

Priority The message priority the senders assign to email messages.

Unread
(Non-sortable)

Whether there are unread email messages when they are grouped into 
Threads. For more information about grouping email messages by thread, 
see “Grouping your email messages” on page 27.

Total
(Non-sortable)

The number of email messages in a conversation when they are grouped by 
Threads.

Location The email folders that email messages are in.

Order Received This is a number that indicates the order that email messages were received 
by an Thunderbird. On some versions of Thunderbird this is a weird number 
that might not be consecutive. They are based on the email message size 
added to the previous Order Received number. They may not be 
consecutive, but they are in order.

Sorting your email messages

The easiest method of sorting email messages is to click the column header you want to sort them 
by. The column that is being sorted is indicated by a triangle on the column header. When the 
triangle is pointed down, the column is being sorted from oldest to newest or alphabetically from 
“A” - “Z”. If it is pointing up, the column is being sorting from newest to oldest or from “Z” - “A”. 
Click the column header again to switch between an ascending or descending sort order.
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Figure 53: Message List pane column sort order
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If what you want to sort by is not displayed as a column, you can either add the column to the 
Message List Pane, or use the View menu to sort the email messages.

To add a column to the Message List Pane

• Right-click anywhere on the Message List Pane column header and select the column 
you want to add. Currently displayed columns are indicated with check marks in the list.

• To display the same column setup in other folders, right-click anywhere on the Message 
List Pane column header, point to Apply columns to and select the folder(s).

◦ You can select an individual folder, or a folder and all of its subfolders (children).
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Figure 54: Add Message List pane columns

Figure 55: Apply columns to other folders
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To reset the displayed columns to the default

• Right-click anywhere on the Message List Pane column header and click Reset 
columns to default.

To sort your email messages using the View menu

• On the View menu, point to Sort by and select how you want to sort your email 
messages. The column currently being sorted is indicated by a dot.

◦ You can also use this submenu to change the sort order from Ascending to 
Descending if the column is not currently displayed.
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Figure 56: Reset columns to default

Figure 57: Sort by menu

Tip!
While you can sort by columns 
that are not being displayed, it 
can get quite confusing.

Mary prefers to display the 
columns that she is sorting so 
she can see at a glance why 
May 6th insists on coming 
between June 8th and June 
9th.
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Grouping your email messages

Earlier, we learned that you can sort your email messages by any of the columns that you can display 
in the Message List Pane. Well, you can also group your email messages by the same columns. 
When you group your email messages, they are all listed under a common entry in the Message List 
Pane that you can expand to view, or collapse to hide. You can also group your email messages by 
conversation with the Thread column.

When Mary is working in an email folder overflowing with email messages, it helps if she can group 
them into categories. Mary usually sorts the email messages in her Saved folder by date, but that 
only puts the most recent messages at the bottom or top of the list. Unfortunately, that list of email 
messages often gets pretty long. What Mary does to help sort her email messages is to also group 
them by date. That way, instead of scrolling through hundreds of messages, May can quickly display 
only email messages that she received today, yesterday, last week, or two weeks ago. Another 
common grouping that Mary uses is by the sender of the email messages. When Mary groups her 
email messages by who sent them, she can see at a glance all the email messages from her boss... or 
she can ignore all the email messages from her boss simply by collapsing the group! However, 
ignoring email messages from your boss is generally not a good idea.

For an example of grouping your email messages, let's see how to group email message by date. You 
can use the same process to group your email messages by any of the Message List Pane columns. 
If the column you want to group by is not showing, see “To add a column to the Message List Pane” 
on page 25 for details on how to display it. 

To group email messages by date

1. Sort the email by date by clicking on the Date column header.
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Figure 58: Email messages grouped by sender

Figure 59: Email messages sorted by date
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2. On the View menu, point to Sort by and then click Grouped By Sort.

3. Click on the triangle beside the grouped email messages to display or hide them.

To remove the grouped display of your email messages, just click on another column header in the 
Message List Pane and the grouping will be removed, leaving the messages sorted by whichever 
column you just clicked.

Another method of grouping your email messages is by thread. We learned at the beginning of this 
chapter that Thunderbird can open email message conversations in a new tab that shows only a 
message and its replies. If you skipped that section, you can take a look at, “Viewing email messages
in a conversation” on page 7 for more information. Well, you can also group email messages by 
thread in the Message List Pane. If you have a lot of back-and-forth email conversations, your 
email folders can get pretty cluttered and it is often difficult finding specific replies in a 
conversation. Grouping by thread can help to keep the clutter to a minimum.
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Figure 60: Sort by submenu

Figure 61: Grouped by date
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To group email messages by thread

• Click the Thread column header in the Message List Pane to toggle the Thread View 
grouping on or off.

4.2 Marking and Tagging email messages
Mary is now down to a mere one-hundred, or so, email messages in her Inboxes. Some of the email 
messages are important, some are time sensitive and need to be addressed immediately, some are work 
related, and others are personal. Without looking at the subject, sender, and sometimes the body of her 
email messages, it can be tough to tell which are which. Mary looks at all the email messages in her 
Inboxes, but sometimes she is in 'scanning' mode; just seeing what a message is about and then moving 
on to the next.

As Mary scans through her email messages, she can mark them as read or unread, assign Stars to them, 
and Tag them with different colours. That way, Mary can see at a glance which she needs to reread, 
which are time sensitive, which relate to projects she is working on, and which are from her Mother 
wondering if she has found a potential husband yet.

Marking email messages as read or unread

Often, as Mary works her way through new email messages, she comes across ones that she doesn't 
have time to read all the way through. Once she has viewed an email message, however, 
Thunderbird marks it as read. In these cases, Mary can mark the email message as unread again.

There are other times that Mary wants to mark email messages as read without even viewing them. 
Mary can usually assume that ninety percent of the email messages from her mother are tips about 
prospective husbands, and doesn't want them cluttering up in her list of unread messages. Her 
mother seems to find a new man for her to marry at every function she attends!
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Figure 62: Thread view grouping
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To mark email messages as read or unread 

1. Select the email message(s) to mark as read or unread in the Message List Pane.

2. Right-click on a highlighted email message, point to Mark and click As Read to toggle 
the status.

• Read messages will have a check mark beside As Read.

Marking email message threads as read

You can mark an entire email message thread as read, as well. The process is more or less the same 
as marking individual email messages as read. Unlike marking individual email messages, however, 
you can not use this command to mark threads as unread. For that you need to mark each email 
message in the thread as unread.

To mark email message threads as read

• In the Message List Pane, right-click on any email message in the thread, point to Mark 
on the shortcut menu and click Thread As Read.
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Figure 63: Marking email messages as unread

Figure 64: Mark a thread as read

Tip!
You don't have to have the 
email messages grouped in 
threads to mark them all as 
read, but it may help to see 
which messages you are 
marking.

For information about how to 
group messages in threads, see 
“To group email messages by
thread” on page 29.
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Marking email messages as read based on their date

Another useful tool that Thunderbird provides is the ability to mark email messages as read based on 
their date. When Mary started her journey down the path of taming her email, she had hundreds of 
email messages in each of her Inboxes. She had already read most of these messages in her other 
email clients before importing them to Thunderbird, but as they were new to Thunderbird, they were 
marked as unread.

Mary can tell Thunderbird to automatically mark the email messages in a folder, or group of Unified 
Folders, that were received between a range of dates as read. For the newly imported email 
messages in all her Inboxes, if Mary is displaying Unified Folders, she can mark them all as read 
with one command.

To mark email messages in all your Inboxes as read based on their date

1. Make sure you are displaying the Unified Folders view in the Folder Pane.

• For more information about displaying Unified Folders, see “Grouping email folders
with Unified Folders” on page 8.

• If you are not displaying Unified Folders, you can still run this on individual folders.

2. Click on the parent Inbox so you are showing the email messages from all the Inboxes.

3. Right-click on any email message in the Message List Pane, point to Mark and click As 
Read by Date.
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Figure 66: Mark email messages as read by date

Figure 65: Displaying email messages from all the Inboxes
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4. Enter the range of dates for the email you want to mark as read in the Mark Messages as 
Read by Date dialog box and click OK.

• Enter the dates as YYYY-MM-DD

Automatically marking email messages as read

As Mary views email messages, Thunderbird automatically marks them as read, but Mary would like 
a few seconds to see what an email message is about before it is marked as read. Mary likes to 
quickly scan through the new email messages in her Inbox looking for important ones to deal with 
first before going back and reading the others. 

To give her the time to see what an email message is about before marking it as read, Mary can 
change the default behaviour of Thunderbird so that it waits a few seconds before changing it.

To automatically mark email messages as read

1. On the Edit menu, click Preferences.

2. Click Advanced and select the Reading & Display tab.

3. Select After displaying for x seconds and enter the number of seconds before 
Thunderbird marks email messages as read when you are viewing them.

Using Stars to mark important email messages

You can assign Stars to email messages as visual reminders, for searching, or to tell Thunderbird 
that they are important. The Star icon is displayed in the Message List Pane beside the email 
message. If the Star icon is filled in, it applies to the message. Thunderbird will also display Stars 
for email messages marked as Starred in Gmail that are downloaded to Thunderbird.
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Figure 67: Mark Messages as Read by Date

Figure 69: Reading & Display tab

Figure 68: Reading & Display tab
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There are a quite a few things you can do with Starred email messages:

• You can assign Stars to email messages as a quick way to mark messages that you want to be 
reminded about.

• You can display Starred email messages using the Quick Filter. For more information about 
the Quick Filter, see “Finding email messages using the Quick Filter” on page 16.

• You can filter Global Search results to show only Starred email messages. For more 
information about filtering Global Search results, see “Filtering Global Search results” on 
page 11.

• You can use the Search Messages tool to search for Starred email messages. For more 
information about the Search Messages tool, see “Advanced searches using the Search
Messages tool” on page 12.

• You can create a Saved Search folder to display all of your Starred email messages. For 
more information about Saved Search folders, see “Creating a Saved Search folder” on page 
14.

• You can create Message Filters that look for Gmail Starred email messages and do things 
like move them to other folders, assign Tags to them, etc. For more information about 
creating Message Filters, see “Filtering email messages” on page 39.

• You can assign Stars to email messages that you don't want Thunderbird to automatically 
delete. For more information about automatically deleting email messages, see 
“Automatically deleting old email messages” on page 58.

To assign a Star to an email message

• Click the Star icon in the Starred column of the Message List Pane to toggle the Star 
on or off.

Stars of a different sort

Thunderbird also displays Stars beside email addresses in the Message Header, but these are 
not the same as Stars assigned to email messages. Instead, the Stars in the Message Header 
show whether an email address is in your Address Book. 

If the Star is filled in, the contact is in your Address Book and clicking on it allows you to edit 
the contact's details. If the Star is just an outline, the email address is not in you Address Book 
and you can click on it to add a new contact.
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Figure 71: Message Header Stars

Figure 70: Assigning a Star to an email message
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Tagging email messages to categorize them

Which email messages are important, which are from friends, which should be dealt with 
immediately, and which are from your Mother? By simply looking at the list of email messages in a 
folder you might not be able to tell which is which. When Mary reads the email messages in her 
Inboxes, she likes to assign colours to the listing in the Message List Pane, depending on which 
category they fall under. That way, after she has finished her quick scan of the new messages, she 
can see at a glance which she needs to deal with first because they are time sensitive, which are work 
related, which are from friends, etc. To do this, Mary attaches Tags to the email messages.

Tags are a list of categories that have colours associated with them. The email messages that have 
Tags are displayed with the matching colour in the Message List Pane, and when Mary reads a 
message, the Tag is shown in the Message Header. If an email message has more than one Tag 
assigned to it, the colour shown in the Message List Pane is of the highest priority Tag, but the 
Message Header shows all the Tags assigned. For more information about Tag priority, see the next 
section, “Tag priority”.

By default, Thunderbird already has some Tags created for you. In order of priority, they are:

• Important

• Work

• Personal

• To Do

• Later

You create as many Tags as you want, or even modify or delete the default Tags. Mary creates Tags 
to identify any common email messages that she receives regularly. For instance, so that she doesn't 
lose messages from meetup.com that request an RSVP, Mary has decided to create a Tag that colours 
them light blue in the Message List Pane.
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Figure 72: Message List pane and Message Header with Tags

Figure 73: Meetup.com RSVP Tag
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Tag priority

The higher a Tag is in the list of Tags, the higher its priority. If an email message has more than 
one Tag assigned to it, the colour of the message in the Message List Pane will be of the Tag 
with the highest priority. The default Thunderbird Tags have predefined priorities assigned to 
them so they will always be at the top of the list, with any Tags you create prioritized 
alphabetically below them. In the following example, the Important Tag has the highest priority 
and Ubuntu Vancouver List Email has the lowest.

To add or remove email message Tags

1. Select the email message(s) in the Message List Pane.

2. Click the Tag button on the Thunderbird toolbar and select the Tag you want to add to or 
remove from the email message(s).

• The Tags assigned to the email message(s) have check marks beside them.

35

Figure 74: Tag list

Tip!
To sort new Tags non-
alphabetically, make the first 
character a number. e.g., 
“1 Shopping” will place it just 
after the last default Tag.

Once a Tag is created, 
however, changing its name 
does not change its priority.

Figure 75: Selecting a Tag to remove from an email message
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To remove all Tags from email messages

1. Select the email message(s) you want to remove all the Tags from in the Message List 
Pane.

2. Click the Tag button on the Thunderbird toolbar and select Remove All Tags.

To create new Tags

1. On the Edit menu, click Preferences.

2. Click Display and select the Tags tab.

3. Click Add.
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Figure 76: Removing all Tags from selected email messages

Figure 77: Display Preferences Tags tab

Figure 78: Display Preferences Tags tab
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4. Type the name of the new Tag, click the grey box to the right of the name and select a 
colour for the Tag.

To create a new Tag while reading an email message

1. While reading an email message, click the Tag button on the Thunderbird toolbar and 
select New Tag.

2. Type the name of the new Tag, click the grey box to the right of the name and select a 
colour for the Tag.
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Figure 81: New Tag name and colour

Figure 79: New Tag name and colour

Figure 80: Add a new Tag to the current email message
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To edit email Tags

1. On the Edit menu, click Preferences.

2. Click Display and select the Tags tab.

3. Select the Tag you want to change and click Edit.

4. Change the name or colour of the Tag.

To delete email Tags

1. On the Edit menu, click Preferences.

2. Click Display and select the Tags tab.

3. Select the Tag to remove from the list and click Delete.
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Figure 85: Display Preferences Tags tab

Figure 82: Display Preferences Tags tab

Figure 83: Edit Tag

Figure 84: Edit Tag

Figure 86: Delete Tag

Tip!
If you delete one of the 
default Tags, making a new 
one with the same name will not 
recreate its priority!

The new Tag will be sorted 
alphabetically, just like any 
other non-default Tag.
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4.3 Filtering email messages
Even after everything Mary has done to tame her email, each of her Inboxes can still receive dozens of 
new email messages every day. It takes a lot of valuable time to work her way through them all. To make 
matters worse, Mary keeps getting junk mail from unsavoury types trying to sell her things that she really 
doesn't need, or even wants to read about! To help her automatically organize her email messages, and to 
get rid of some of the junk mail, Mary needs to creates some Message Filters.

A Message Filter reads your email messages, checking them for keywords, who sent them, who they are 
to, their status, and just about anything else you can check for in an email message. When it finds an 
email message that matches the Message Filter, it will do something to it. For instance, you can create a 
Message Filter that moves email messages from meetup.com to a folder called Meetup Email Messages. 
Or you can have a Message Filter that reads the body of email messages looking for the words “someone 
you should meet” and automatically deletes them if they are from your mother!

Deciding how to filter your email messages

The first thing you need to do when creating Message Filters, is to plan! Just 
like the old adage, “measure twice, cut once”, you need to carefully think 
through when you want the Message Filters to run, what you want to filter your 
email messages for, and then what you want to do with them.

When to run Message Filters

The first thing you need to do, is to decide when you want the Message 
Filters to run. For each Message Filter you create, you tell it when you want 
it to act. 
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Figure 87: Mary's Inboxes full of email messages
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There are five ways to run Message Filters:

• When Thunderbird checks for new email messages.

◦ This allows a Message Filter to do its thing automatically before the email messages 
make it to your Inbox. For instance, you can have email messages from friends 
automatically put in their own folder.

• When you manually run Message Filters.

◦ When you tell a Message Filter to run manually, new email messages arrive in your 
Inbox so you can look at them before you run Message Filters. This way, you can do 
things like add Tags that the Message Filter looks for, or mark them as Junk.

• When Thunderbird checks for new email messages or when you manually run Messages 
Filters.

◦ This allows a Message Filter to run automatically when Thunderbird checks for new 
email messages, and it will also run when you manually run Message Filters.

• When Thunderbird checks for new email messages, but after Junk Mail Controls have 
checked the messages. (Thunderbird calls this, “after classification”)

◦ You may want to run Message Filters on email messages that Thunderbird marks as 
Junk, automatically deleting particularly distasteful ones. For more information 
about email messages marked as Junk, see “Using the Junk Mail Controls” on page 
50.

• When Thunderbird checks for new email messages or when you manually run Message 
Filters, but after the Junk Mail Controls have checked the messages. (Thunderbird calls 
this, “after classification”)

◦ You can use this to automatically delete email messages that Thunderbird marks as 
Junk, and to delete distasteful email that sneak past the Junk Mail Controls into 
your Inbox.

What email messages to filter

There are many different strategies you can use to filter your email messages. For instance, you 
can filter a message based on:

• Who the email message is from.

• Who the email message is to.

• Where the email message is from.

• Words or phrases in the email message subject.

• Words or phrases in the body of the email message.

• The date of the email message.

• How old the email message is.

• The Priority of the email message.
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• Tags assigned to the email message.

• If the email message has a Gmail Star.

• The size of the email message.

You can also create custom Message Filters to look for certain things hidden 
away in the data that normally only email servers look at, but that is way beyond 
the scope of this guide. Suffice it to say, that if it pertains to an email message, 
you can create a Message Filter to search for it and then do something to it.

What to do with email messages that match your Message Filter

Doing something to an email message; that's the next thing you need to plan. Some of the things 
you can tell Thunderbird to do with an email message that matches a Message Filter are:

• Move the email message to another folder.

• Copy the email message to another folder.

• Forward the email messages to another email address.

• Automatically send a response to the email sender. (e.g. Vacation response)

• Mark the email message as read.

• Add a Star to the email message.

• Set the Priority of the email message.

• Set the Junk status of the email message.

• Delete the email message.

• Delete the email message from the email server.

• Retrieve the entire email message from the email server.

Some common Message Filtering strategies

The most common strategy for using Message Filters is move matching email 
messages from your Inbox to other folders. This is a great way to keep the clutter 
in your Inbox to a minimum. If you receive a lot of email messages from 
meetup.com, why not have Thunderbird automatically move them into a folder 
called Meetup Email Messages? That is what Mary has decided to do. Mary also 
uses Message Filters to move work-related email messages to a folder called Work, messages 
from friends to a folder called Friends, and messages from her family to one called Family. 

If you don't want to scatter the email messages from your Inbox all over the 
place before you read them, another common method of filtering messages 
is to assign Tags, Priorities or Stars to them. You can still see all your 
messages in one place, but you don't have to manually categorize each one. 
After reading them, however, you should still move them out of your Inbox 

or delete them. It is not a good practice to keep everything in the Inbox as it increases 
the load on Thunderbird and may lead to corrupted email messages.
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Mary actually uses a combination of these two strategies. In addition to moving 
work-related email messages to her Work folder, she also assigns them Tags 
indicating the project they are related to. If it is an important project, she might also 
set the Priority of the email messages to High or Highest. For really important 
email messages, Mary will add a Star to them. That way she can quickly find them 
in her Work folder.

There are many ways to filter email messages:

• Often, business email messages are assigned a Priority when they are sent. You can use 
this to group them with Tags, Stars or in their own folders.

• Look for frequently used words or phrases in the subject lines to group or Tag email 
messages.

• Filter email messages from friends telling you the latest jokes into their own folders.

• Don't use the Inbox as a to-do list to yourself, instead use the word “To-Do” in the email 
message subject and filter them into another folder.

• As you read email messages, assign Tags like, “Review Daily”, “Review Weekends”, 
“Review Someday”, and “Review Optional” so you can then use a Message Filter to 
move them out of the Inbox to deal with later.

• Automatically forward personal email messages sent to a work account to your home 
email address and then delete them from the work Inbox.

Creating Message Filters

When you create a Message Filter you are only creating it for a single email account. If you have 
more than one email account set up in Thunderbird and want to filter them all for the same thing, 
you need to create a Message Filter for each.

There are two ways you can create a Message Filter. You can create one from scratch, or you can 
create one from the sender of the email message you are currently reading. However, creating a 
Message Filter from the current email message isn't much different than creating one from scratch. 
You get the same window, but the sender's email address is already listed in the search criteria, what 
Thunderbird calls Filter Rules. If you have read the section about “Advanced searches using the
Search Messages tool” on page 12, you will recognize the layout of the Filter Rules window as it 
does the same thing; it searches email messages for matches to the search criteria. Unlike using the 
Search Messages tool that just displays matching email messages, Message Filters also have 
section where you define what to do with email messages they find.
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To create a new Message Filter

1. On the Tools menu, click Message Filters.

2. Select the email account you want to create the Message Filter for in the drop-down list.

3. Click the New button.

4. Give the Message Filter a name that you will recognize.

5. Select when to run the Message Filter.
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Figure 88: Message Filters

Figure 89: Message Filters

Figure 90: Filter Rules

Figure 91: Filter Rules
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6. Select how the Message Filter will match the Filter Rules.

7. Click the first drop-down list and select what part of the 
email message to search in.

8. Click the second drop-down list and select how you want to match the Filter Rule.

9. Type the search criteria in the text box or select it from the drop-down list, depending on 
what is being searched for.
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Tip!
• Match all of the following 
finds messages that match all 
the Filter Rules.

• Match any of the following 
finds messages that match at 
least one Filter Rule.

• Match all messages finds all 
messages, even if there are 
no matches to Filter Rules.

Figure 92: Filter Rules

Figure 93: Filter Rules

Figure 94: Filter Rules

Figure 95: Filter Rules
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10. Click the plus sign to add more Filter Rules.

11. Click the first drop-down list in the Perform these actions section and select what you 
want the Message Filter to do with matching email messages.

12. Click the second drop-down list and further define the what you want done with the 
email messages, if applicable.

45

Figure 96: Filter Rules

Figure 97: Filter actions

Figure 98: Filter actions

Tip!
Depending on what you select 
in the first drop-down box, 
there might not be a second 
drop-down box. For instance, 
if you tell the Message Filter 
to delete matching email 
messages, you don't have to 
tell it anything else.
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13. Click the plus sign to add more actions you want the Message Filter to perform on 
matching email messages.

To create a Message Filter from the sender of the current email message

• Right-click on the sender's name or email address in the Message Header and click 
Create Filter From. The Filter Rules window will open with the sender's email address 
already filled in for you. The rest of the steps are the same as those in, “To create a new
Message Filter” on page 43.

Message Filter order

When Thunderbird checks an email message, it runs each Message Filter in the order it appears in 
the Message Filters window, from top to bottom. If one Message Filter marks an email message 
High priority, it may get changed if the next Message Filter says it should be marked Low priority. 
The second Message Filter overwrites the change the first made. This is why Thunderbird allows 
you to change the order of the Message Filters.

To change the order Message Filters are run

1. On the Tools menu, click Message Filters.

2. Select the account you want to change the order of the Message Filters for.
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Figure 100: Create a filter from an email message

Figure 99: Filter actions

Figure 101: Message Filters
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3. Select a Message Filter and move it up or down in the list using the Move Up and Move 
Down buttons.

Stopping further Message Filter checks on a match

Sometimes, you might want Thunderbird to stop checking for matches when an email message 
matches a Message Filter. Say, for instance, you have a Messages Filter that sets the Priority of 
email messages from your boss as Highest, and you have another one that sets messages with the 
word joke in the subject line to the Lowest priority. It wouldn't be a good career move if a message 
from the boss telling you the latest joke gets marked as Lowest priority, and you don't read it and 
applaud him for a his outstanding wit! The way to save your career, and to continue to put food on 
the table for your family, would be to make sure the Message Filter that marks email messages from 
your boss with the Highest priority stops checking the other Message Filters. To do this, make the 
Message Filter's last action, Stop Filter Execution.

Running Message Filters

If you set a Message Filter to run only when checking for mail, it does its thing on new email 
messages without any prompting from you. If, however, you told a Message Filter to only run 
manually, you need to tell Thunderbird to run it if you want it to work its magic. A Message Filter 
set to run both when Thunderbird checks for mail and manually, will run automatically, but it will 
also run when you tell the Message Filters to run. When you manually run Message Filters you can 
check certain folders, run specific Message Filters, or only check selected email messages.
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Figure 102: Message Filters

Figure 103: Filter actions
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To manually run Message Filters on a folder

1. In the Folder Pane, click on a folder you want to run the Message Filters in.

• Note: If you are displaying Unified Folders, you need to have a subfolder of the 
parent Unified Folder selected. For more information about Unified Folders, see 
“Grouping email folders with Unified Folders” on page 8.

2. On the Tools menu, click Run Filters on Folder.

To manually run Message Filters on selected email messages

1. Select one or more email messages in the Message List Pane.

2. On the Tools menu, click Run Filters on Message, or Run Filters on Selected 
Messages.
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Figure 104: Selected folder to run Message Filters in

Figure 105: Tools menu

Figure 106: Tools menu
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To manually run specific Message Filters on a folder

1. Click on the folder you want to run the Message Filter(s) on.

• Note: If you are displaying Unified Folders, you need to have a subfolder of the 
parent Unified Folder selected. For more information about Unified Folders, see 
“Grouping email folders with Unified Folders” on page 8.

2. On the Tools menu, click Message Filters.

3. In the drop-down list, select the email account that contains the Message Filter(s).

4. Hightlight one or more of the Message Filters.

• Holding the CTRL key down when clicking allows you to select multiple filters.
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Figure 108: Tools menu

Figure 109: Message Filters

Figure 107: Selected folder to run Message Filters on

Figure 110: Message Filters
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5. Select the folder to run the highlighted Message Filter(s) on in the drop-down list and 
click Run Now.

Using the Junk Mail Controls

Mary doesn't really think she needs to consider taking Viagra, so why do so many of her email 
messages feel she should? Junk mail, or spam, is the bane of modern email users. It is so much of a 
problem, that a whole industry has sprung up to combat it. Not only is spam annoying millions of 
email users, but in some cases it can be downright dangerous to you or your computer. Spam can 
contain links to dangerous Web sites or computer viruses, and it can even try to sell you 'prescription 
drugs' that are not only fake, but they may even harm you. Most email providers try to warn you in 
the subject line about junk mail, or filter it out before it gets to you, but they aren't perfect.

Once again, Thunderbird comes to the rescue. Using Junk Mail Controls, 
Thunderbird can detect and filter unwanted email messages to save you the 
aggravation. It's like giving Thunderbird an inoculation to protect it from spam. 
Instead of letting your email provider delete junk mail, it might even be a good idea 
to let them mark the junk mail and send it to you anyway. That way, Thunderbird 
can filter them into a folder so you can review them before deletion. Even the best 
junk mail filters have been known to make mistakes! It wouldn't be good if email messages from a 
client get mistakenly deleted because they looked like spam.

Junk Mail Controls are configured separately for each account in Thunderbird. By default, they are 
turned on but not doing anything. Before Thunderbird can use them to filter spam, you must first 
train them to figure out what is junk and what isn't. When you train Junk Mail Controls, you are 
teaching them to look for certain words, email addresses or other parts of messages that indicate they 
might be junk mail. You need to train them by marking both junk mail and email messages that are 
not junk mail. The more email messages you mark, the more accurate the Junk Mail Controls will 
be. Before the Junk Mail Controls can really work effectively, though, you need to mark at least 
one-hundred messages as Junk and one-hundred as Not Junk. Once you mark an email message as 
Junk you can delete it as Thunderbird makes a record of the information it needs.

Like any learning in life, it's an ongoing process. You need keep marking new junk email messages 
that slip through and occasionally mark good messages, just to keep Thunderbird trained. A good 
habit is to mark a few messages as good every time you mark any as bad.
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Figure 111: Message Filters
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Once Junk Mail Controls are configured, they run automatically when email messages are received 
and after the Message Filter are run. Email messages marked as spam will have a flame icon in the 
Junk Status column of the Message List Pane and a bar at the top of the Message Pane telling you 
it is Junk Mail.

To configure Junk Mail Controls

1. On the Edit menu, click Account Settings.

2. Click Junk Settings for the account you want to configure.

3. Ensure the Enable adaptive junk mail controls for this account check box is selected.

4. Select the check boxes for Address Books that contain email address you don't want 
marked as Junk.
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Figure 112: Junk Mail

Figure 113: Junk Settings

Figure 114: Junk Settings

Figure 115: Junk Settings
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5. If you or your email provider use SpamAssassin or SpamPal to filter junk mail, select the 
Trust junk mail headers set by check box and choose the product in the drop-down list.

6. Select the Move new junk messages to check box and 
choose where you want the junk mail moved to.

7. Select the Automatically delete junk mail older than check box and enter the number 
of days you want to keep email messages marked as Junk.

To classify email messages as Junk or Not Junk

1. Select the email message(s) in the Message List Pane.

2. Right-click on a selected email message in the Message List Pane, point to Mark and 
click As Junk or As Not Junk.
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Figure 116: Junk Settings

Tip!
SpamAssassin and SpamPal are 
two major spam filtering 
software products that 
Thunderbird can use 
information from to filter 
spam. If you are not sure if 
your server or email provider 
uses them, you can leave this 
unchecked.

Figure 117: Junk Settings

Figure 118: Junk Settings

Tip!
Be Careful! Even when 
Thunderbird is well-trained, it 
can still make mistakes!

Figure 119: Marking messages as Junk

Tip!
You can also mark the email 
message you are reading as 
Junk by clicking the Junk 
button on the Message 
Header.
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To remove the Junk classification from email messages

1. Select the email message in the Message List Pane.

2. Click the Not Junk button on Junk Mail bar at the top of the Message Pane.

To delete all email messages marked as Junk from a folder

1. Select a folder in the Folder Pane.

• Note: If you are displaying Unified Folders, you need to have a subfolder of the 
parent Unified Folder selected. For more information about Unified Folders, see 
“Grouping email folders with Unified Folders” on page 8.

2. On the Tools menu, click Delete Mail Marked as Junk in Folder.

To set default junk mail preferences for all folders

1. On the Edit menu, click Preferences.

2. Click Security and select the Junk tab.
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Figure 122: Tools menu

Figure 121: Selected folder to delete junk mail from

Figure 123: Preferences Junk tab

Figure 120: Not Junk button in the Message Pane
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3. Select the When I mark messages as junk check box and choose if you want to Move 
them to the accounts “Junk” folder or Delete them.

4. Select Mark messages determined to be Junk as read if you don't want them showing 
up as unread.

5. Select Enable junk filter logging to keep a record of what the Junk Mail Controls do.

• You can click the Show log button in this window to display the log.

• Thunderbird doesn't always write to the log immediately. If you are finding that the 
log is not being updated, restarting Thunderbird will force it to write to the log.

6. Click Reset Training Data to reset everything the Junk Mail Controls have learned and 
start the training from scratch.
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Figure 125: Preferences Junk tab

Figure 124: Preferences Junk tab

Figure 126: Preferences Junk tab

Tip!
Junk Mail Controls only run 
on new mail. This setting 
moves or deletes downloaded 
messages you mark manually.

Tip!
Warning, this resets the Junk 
Mail Controls for all of your 
accounts and you must retrain 
them before they can become 
effective.

Figure 127: Preferences Junk tab
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5 Archiving and Deleting Your Email Messages
Once Mary has read and dealt with email messages, she either saves or 
deletes them. The main thing is that she gets them out of her Inbox. It is 
important that Mary not store all her email messages in the Inbox as it can 
cause all sorts of problems and headaches. Storing everything in the Inbox 
can really slow Thunderbird down when it has to read through 5,000 email 
messages every time it opens a folder or does a search. That's the headache 
part, but the biggest reason for not storing everything in the Inbox is that it 
increases the chances that email folders can become corrupted. The larger 
the folder, the more chance that something can go wrong. Mary is generally 
a very polite person, but she is liable to use some very inappropriate language if she suddenly loses 5,000 
email messages! Her boss has an even more colourful vocabulary when it comes to problems that affect 
the business.

Not only should Mary not store all 5,000 email messages in her Inbox, but they shouldn't all be stored in 
any single folder. This is where Archiving and deleting email messages come in. Archiving moves email 
messages that Mary wants to keep into a new Archive folder. Deleting messages removes them, sort of. 
There is a bit more to deleting email messages than just pressing the Delete button, as you will see later in 
this chapter in “Compacting folders” on page 61.

5.1 Archiving old email messages
After Mary reads a new email message that she wants to keep, she save it into another folder. That way 
she can quickly find work email messages, replies from online vendors, all the jokes her friends have sent 
her, and other groupings of common messages. However, Mary gets a great deal of work-related email 
messages and her Work folder is getting quite large. A good method of keeping the size of the folder 
down, and keeping Thunderbird running smoothly, is to Archive old messages. Archiving email 
messages moves the messages out of the folder they are in and into special Archive folders.

Setting up and using Archiving

Generally, when Thunderbird Archives email messages, it moves them 
into an Archive folder that has subfolders based on year the messages 
are from. For instance, when displaying the All Folders view, Mary 
has a folder named 2010 inside an Archives folder under 
mary.dickens33@yahoo.ca. For more information about the All 
Folders view, see “Grouping email folders with Unified Folders” on 
page 8.
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Tip!
When messages are Archived, 
they are simply put in a folder 
named after the year, but what 
folder did they come from?

Tagging the messages with the 
folder name before Archiving 
them is a good way to see 
what the original folder was.

Figure 128: Archive folders in the All Folders view
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If Mary is displaying the Unified Folders view, and has more than one email account, her Archives 
folders will look like this:

Gmail, does things a little differently than other email providers when it comes to Archiving email 
messages. Gmail POP3 accounts work the same as other accounts, but Gmail IMAP accounts are set 
to move Archived email messages into the All Mail folder. The All Mail folder is a special folder 
that Gmail puts all your email messages into and it doesn't group them by year. When you view your 
email in Google's webmail, you aren't actually seeing folders like Thunderbird uses. What Gmail 
does is put all the messages into the All Mail folder and give them labels like Inbox, Saved, etc. The 
folders you see in webmail are basically like Thunderbird's Saved Search folders; just groups of 
email messages with the same label. Take a look at “Creating a Saved Search folder” on page 14 if 
you aren't sure what Saved Search folders are.

This is what one of Mary's Gmail Archives folders look like when displaying the Unified Folders 
view. It is the same as other Archives folders, but doesn't have the subdirectory named after the year. 
The folder also contains all her Gmail messages, not just the Archived ones.

If Mary is displaying the All Folders view, Gmail's All Mail folder is a little harder to find. It can 
found it buried under the [Gmail] folder.

Archiving your Gmail IMAP messages is almost redundant because the All Mail folder stores 
everything anyway. The advantage of Archiving Gmail IMAP messages is that you can do things 
like add Tags to them before archiving them.
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Figure 129: Archives folder in the Unified Folders view

Figure 131: Gmail's Archive folder in the All Folders view

Figure 130: Gmail's Archives folder in the Unified Folders view
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As with many other preferences in Thunderbird, you can change the default folders that email 
messages are Archived to.

To set the default Archive folder

1. On the Edit menu, click Account Settings.

2. Click on Copies & Folders under the account you want to change.

3. In the Drafts, Archives, and Templates section, click “Archives” Folder on or Other 
and select the folder you want to save Archived email messages to.

• If you select “Archives” Folder on, Thunderbird will 
create a folder called Archives under the account you 
choose.

To Archive email messages

You can Archive email messages by either:

• Selecting one or more email messages in the Message List 
Pane and pressing the letter A on your keyboard.

• While reading an email message, click the Archive button 
on the Message Header.
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Tip!
If you want to remove 
archived messages from an 
IMAP server, select Local 
Folders.

Local Folders are stored on 
the computer, not on the 
IMAP server.

Tip!
To quickly Archive messages 
based on their age, for 
instance older then one month, 
create a Saved Search folder. 
That way you can select 
everything in the folder and 
Archive it.

See “Creating a Saved Search
folder” on page 14 for more 
information.

Figure 132: Copies & Folders in the Account Settings

Figure 133: Archives folder location

Figure 134: archive button
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5.2 Deleting email messages
After reading many of her new email messages, Mary simply deletes them. By deleting them, she is 
moving them from her Inbox to her Trash folder. This is great, but Mary also needs to periodically empty 
deleted email messages from her Trash folders, too. As was mentioned at the beginning of this chapter, it 
is not a good practice to store too many email messages in any one folder. This is true for the Trash folder, 
as well. Too many email messages just slows Thunderbird down and is a recipe for a corrupted folder. For 
Mary's IMAP accounts, deleting email messages can also keep the size of the messages stored on the 
email server from exceeding the space she is given.

Mary can manually empty the Trash folder every so often, but she can also have Thunderbird 
automatically do it for her.

Automatically deleting old email messages

Manually emptying the Trash folder is fine, so long as you keep on top of it. If you don't, your Trash 
folders can start to balloon in size, especially if you receive a lot of email message with attachments. 
Mary has decided to have Thunderbird automatically empty her Trash folders for her so she doesn't 
have to remember to do it regularly.

There are two ways that Thunderbird can automatically remove email messages from the Trash 
folders; using folder Retention Policies or emptying the Trash when Thunderbird exits. Folder 
Retention Policies are rules that automatically delete email messages that are a certain number of 
days old, or based on the number of messages in a folder. You can set Retention Policies globally 
for all folders in an account, or on each individual folder. Most often, they are used to automatically 
delete email messages from the Trash as it is uncommon for people to want their saved email 
messages to be automatically deleted. Generally, people remove saved email messages manually.

Having Thunderbird automatically empty the Trash when it exits is another common way to keep the 
size of the Trash folders down. When this is set, every time you exit Thunderbird, all the email 
messages in the Trash folder are removed. This works well if you exit Thunderbird every so often, 
but unlike in Windows, some Ubuntu users keep their computer running for months at a time, seldom 
needing to exit Thunderbird because they need to do a reboot.

To set the Retention Policy for all folders in an account

1. On the Edit menu, click Account Settings.

2. Click Synchronization & Storage (IMAP accounts) or Disk Space (POP3 accounts) 
under the account you want to configure.
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Figure 135: Synchronization & Storage in Account Settings

Tip!
On POP3 accounts, message 
Retention Policies are applied 
immediately, but it can 
sometimes take up to a day 
for them to be applied to 
IMAP accounts.
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3. Select Delete all but the most recent xxxx messages or Delete messages more than xx 
days old and set the number of email message or the age of messages to keep.

4. Leave the Always keep starred messages check box selected if you don't want 
Thunderbird to automatically delete email messages that have Stars.

To set the Retention Policy for a single folder

1. Right-click on a folder in the Folder Pane that you want to configure the Retention 
Policy for, and click Properties.

• Note: If you are displaying Unified Folders, you need to have a subfolder of the 
parent Unified Folder selected. For more information about Unified Folders, see 
“Grouping email folders with Unified Folders” on page 8.

2. Select the Retention Policy tab.
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Figure 136: Account Settings automatic delete settings

Figure 137: Account Settings automatic delete settings

Figure 138: Selecting Properties for a Trash folder

Figure 139: Retention Policy tab in Folder Properties

Tip!
On POP3 folders, Message 
Retention Policies are applied 
immediately, but it can 
sometimes take up to a day 
for them to be applied to 
IMAP folders.
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3. Clear the Use my account settings check box.

• This overrides any Retention Policies you set for the email account in the Account 
Settings.

4. Select Delete all but the most recent xxxx messages or Delete messages more than xx 
days old and set the number of email message or the age of messages to keep.

5. Leave the Always keep starred messages check box selected if you don't want 
Thunderbird to automatically delete email messages that have Stars.

To empty the Trash folder on exit

1. On the Edit menu, select Account Settings.

2. Under the account that you want to empty the Trash on exit for, click Server Settings.
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Figure 140: Retention Policy tab in Folder Properties

Figure 141: Retention Policy tab in Folder Properties

Figure 142: Retention Policy tab in Folder Properties

Figure 143: Server Settings in Account Settings
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3. Select the Empty Trash on Exit check box in the Server Settings section.

5.3 Compacting folders
If Mary doesn't need to keep old email messages, she deletes them, but deleting an email message doesn't 
really delete it! Each folder in the Folder Pane is actually two files on your computer's hard disk; a text 
file containing all the email messages in the folder, and an index file that points to where in the text file 
each message is. For instance, there is an Inbox file that holds all the email messages for Thunderbird's 
Inbox folder, and an index for it called Inbox.msf. When an email message is added to a folder, it is added 
the end of the folder's text file and entry is added to the index file telling Thunderbird where it is. 

When you tell Thunderbird to delete an email message from your Inbox, it just copies it to the Trash 
folder and removes the index entry for it in the Inbox.msf. It removes the message's entry in the index, 
hiding it in Thunderbird's Inbox folder, but it does not remove the message from the Inbox text file! This 
is good and bad. It is good in that you can recover email messages that were accidentally deleted, but it is 
bad because the real size of the folder file keeps growing and growing, even if it looks empty.

Thunderbird does the same thing when you move an email message; it sends a copy to the new folder and 
hides it in the original folder. Imagine if you move a 20 MB email message from your Inbox to your 
Saved folder and then to your Work folder. All of a sudden, that one 20 MB email message is now using 
60 MB of space on your computer! What you need to do is remove the old messages that Thunderbird 
hides from you.

To really remove deleted email messages, Mary needs to Compact her folders. When Mary Compacts 
Thunderbird's folders, it permanently removes the deleted email messages from the folder's text file, 
reducing the possibility that the folder will get too large and possibly become corrupted.

Setting up and using folder Compacting

There are three methods of Compacting folders; manually Compacting folders, Compacting 
folders at exit, or having Thunderbird automatically Compact folders. There are pros and cons with 
each method.

Automatically Compacting your folders makes sure that they are always Compacted, but if you do 
anything in Thunderbird that writes to a folder while it is being Compacted, you may cause some 
corruption and data loss. It's best to only read messages while Compacting is going on. Thunderbird 
will tell you it is Compacting in the Status Bar at the bottom of the window. If you set automatic 
Compacting to be done frequently, it will only take a moment to Compact your folders.
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Figure 145: Thunderbird Status Bar

Figure 144: Server Settings in Account Settings
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The safest methods of Compacting folders are to do it manually or when Thunderbird exits. 
However, if you choose either of these methods, you must be diligent about doing it. Don't let your 
folders get too big or you might be asking for trouble! When you choose to Compact folders on exit, 
Thunderbird will automatically Compact your IMAP Inbox or Trash folders when you close the 
program. Unfortunately you can't set POP3 Inboxes to Compact on exit, you need to do them 
automatically or manually. Emptying a Trash folder also compacts it, so you don't need to worry 
about Compacting it if you have told Thunderbird to empty the Trash when exiting.

To manually Compact all folders in an account

1. In the Folder Pane, select any folder in the account you want to Compact.

2. On the File menu, click Compact Folders to Compact all the folders in the account.

To manually Compact a single folder

• Right-click on the folder in the Folder Pane and click 
Compact.
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Figure 148: Compacting a folder

Tip!
You can make it easier to 
Compact a folder by adding a 
Compact button to the 
toolbar.

Just right-click on the toolbar, 
select Customize and drag the 
Compact button to where you 
want it.

Figure 146: Folder selected in the account to compact

Figure 147: Compacting an account's folders
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To Compact the Inbox or Trash folders at exit

1. On the Edit menu, click Account Settings.

2. Click on Server Settings under the account you want to set up Compacting for.

3. In the Server Settings section, select the Clean up (“Expunge”) Inbox on Exit and/or 
Empty Trash on Exit check boxes.

• Note: The Expunge option is only available for IMAP accounts.

To configure automatic Compacting

1. On the Edit menu, click Preferences.

2. Click Advanced and select the Network & Disk Space tab.

3. In the Disk Space section, select the Compact folders when it will save over xxx KB 
check box.

• Note: Leaving the number of KB (kilobytes) at the default value makes sure that the 
Compacting process doesn't take too long and folders are kept clean of deleted email 
messages.
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Figure 149: Server Settings in Account Settings

Figure 150: Clean up ("Expunge") Inbox on Exit

Figure 151: Network & Disk Space tab in Preferences

Figure 152: Disk Space section of Network & Disk Space
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5.4 Backing up Thunderbird
The most important 'Best Practice' that Mary can follow is to back up Thunderbird 
regularly. No matter how good Thunderbird or her computer are, there are times when 
the planets align and catastrophic things happen! If Mary's computer starts puffing out 
clouds of smoke or gets sucked into a black hole, it's probably too late to save her data.

There are two ways that Mary can safeguard her email information; she can back up the 
Thunderbird profile or she can save her emails messages.

Backing up the Thunderbird profile

This is the best method of protecting your Thunderbird information. Thunderbird stores all of its 
configuration settings and email messages in a folder on your computer's hard drive. If you copy this 
folder to a new computer, you can fire up Thunderbird to exactly the same state it was when you 
saved the profile. The profile folder is named .thunderbird and is in the root of your Home folder. 
You can open your Home folder by selecting it on the Ubuntu Places menu, however, by default you 
won't see the .thunderbird folder. That's because it has a period in front of its name making it hidden. 
It's not a problem, though, because it is a simple task to show hidden files and folders.

It is important that when you back up your Thunderbird profile, you don't just copy it to somewhere 
else on the same computer. Remember, when the planets align and you computer gets sucked into a 
black hole, having two copies of the profile on the computer won't help you much! To show you how 
to back up your profile, we'll use a USB flash drive. Just don't forget to remove the flash drive before 
your computer gets sucked into that black hole!

To copy the Thunderbird profile to a USB flash drive

1. Exit Thunderbird.

2. Insert your USB flash drive and make sure it is recognized.

3. On the Ubuntu Places menu, click Home Folder.
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Figure 153: Ubuntu Places menu
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4. On the View menu, click Show Hidden Files to show the .thunderbird folder.

5. Right-click on the .thunderbird folder and click Copy.

6. Click on your USB flash drive in the list of Places on the left side of the window.

• The contents of the USB flash drive will be displayed in the right side of the window.

7. Right-click in the USB flash drive where you want to save the profile and click Paste.

There you have it, you now have a backup copy of your Thunderbird profile. To restore the profile 
on your new 'black hole proof' computer, just install Thunderbird and copy the .thunderbird folder to 
your Home folder. You can overwrite any existing .thunderbird folder, so long as you haven't used 
it yet! If the .thunderbird folder you overwrite has been used, you will lose any data in it.
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Figure 154: Show Hidden Files

Figure 155: Copy the .thunderbird folder

Figure 156: Opening the USB flash drive

Figure 157: Paste the .thunderbird folder
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But what if you don't want to back up the whole profile? Maybe you just backed it up and you only 
want to save a copy of one or more email messages. You can do that, too. We'll use the same USB 
flash drive to save the email messages to.

To save one or more email messages to a USB flash drive

1. Insert your USB flash drive and make sure it is recognized.

2. In the Message List Pane, select the email message(s) you want to save.

3. On Thunderbird's File menu, point to Save As and click File.

4. Click on the USB flash drive under Places on the left side of the Save Message As 
window and click Save.

The email messages are now saved to the USB flash drive. Each message is named after the subject 
of the email. If you want to open them in Thunderbird, all you have to do is select Open Saved 
Message from the Thunderbird Files menu, and select the saved email messages.
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Figure 158: Selected message to save

Figure 159: File menu Save As

Figure 160: Save Message As
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6 Putting It All Together
Do you feel like an expert now? OK, maybe not an expert, but you now know your 
way around Thunderbird better than most people. After all the new tools that you 
and Mary have learned about in your journey from a fresh installation of Mozilla  
Thunderbird 3.1 to here, you should have no problem keeping your email from 
becoming a tangled forest of dread!

We started off learning more effectively ways to view your email messages by 
grouping related messages in conversation tabs and by grouping folders with 
Unified Folders. We also saw how the powerful search tools at your command in 
Thunderbird makes finding email messages a breeze. Especially useful for Mary 
are the Saved Search folders, where she can group email message by nearly any 
criteria she wants and have the results automatically updated.

Another couple of great tools for finding email messages to view are the Quick Filter and Mail Views. 
Using these to filter the email displayed messages really helps Mary zero in on the messages she need to 
look at.

Next, we looked at how Thunderbird can help you organize and prioritize email messages by sorting, 
grouping, Marking, Tagging and running Message Filters them. By sorting and grouping her email 
messages, Mary is able to deal with the important ones quickly and leave those that aren't until later. 
Tagging and Marking are very helpful for making the important email messages stand out from the rest, 
and Message Filters let Mary automatically deal with many of her email messages.

Finally, in the the section on Archiving and deleting email messages, Mary discovered that not only is 
Archiving and deleting email messages a good way to clean up her folders, but it also helps Thunderbird 
run more efficiently and prevents corrupted messages. In the rare case that there is a problem, Mary also 
learned how to back up her email messages.

6.1 Some Best Practices
To wrap up this guide, we should probably take a quick look at some of the 'Best Practices' you should 
take away from it. These are important things to remember, and can help you manage your email and 
keep Thunderbird running smoothly:

• The number one best practice is to back up your email! The best way to do 
this is to copy the Thunderbird profile directory to somewhere other than 
your computer.

• Keep the number of email messages in a folder to a minimum. Bloated 
folders are a sure way to end up with corrupted email messages. Move 
messages out of your Inbox, and if your saved folders get too large, create 
additional folders.

• Compact your folders regularly. If you don't compact your folders regularly, 
they may get too large and slow Thunderbird down, if you are lucky. If you 
are unlucky, you may lose email messages!

• Use Message Filters to help identify important, and not so important 
messages, and then automatically move them out of the Inbox.
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6.2 A final word
Like many products, Mozilla Thunderbird and Ubuntu are constantly updating themselves and evolving. 
This guide was written for Ubuntu 10.10 and Thunderbird 3.1, and future versions of the software will 
almost certainly have changes. If you find that things don't work quite the same way as was explained in 
this guide, you may need to visit the support site for the software, or your local users group.

The Mozilla Messaging Support Web site is a good place to find information about using Thunderbird, 
however, you may have better luck asking your questions about running Thunderbird on Ubuntu at the 
Ubuntu Vancouver LoCo. Ubuntu Vancouver LoCo is an Ubuntu users group for Vancouver, Canada. 
Being a local users group, the members and happy to help other locals learn the joy of Ubuntu. If you 
don't live in the Vancouver area, Meetup.com is a good place to find a users group near you. Launchpad 
can also be a valuable source of information about using Thunderbird and Ubuntu.

• Mozilla Messaging Support:

◦ http://www.mozillamessaging.com/en-US/support/  

• Ubuntu Vancouver LoCo:

◦ http://www.meetup.com/ubuntuvancouver/  

• Meetup.com

◦ http://www.meetup.com/  

• Launchpad:

◦ https://launchpad.net/  

Well, you made it! You have found your way through the Email Forest and 
tamed your email. You now have all the tools you need to master the fine 
art of Thunderbird email. You'll never again need to complain that you have 
'just too much email!', and the only time 'Arrgh!!!' should escape your lips 
is when the boss sends you, yet another, change to a project you are 
working on! 

Good luck and happy emailing.

68

https://launchpad.net/
http://www.meetup.com/
http://www.meetup.com/ubuntuvancouver/
http://www.mozillamessaging.com/en-US/support/


Glossary

Glossary

Address Books Group A container in Thunderbird's Address Book used to group common 
email addresses.

After Classification A Thunderbird filter term for running Message Filters after email 
messages have been checked by the Junk Mail Controls.

All Folders View A Thunderbird email folder view that groups email folders based on 
the email account the are in.

All Mail Folder A Gmail account's email folder that holds every email message in 
the account. It is also created in Thunderbird when a Gmail IMAP 
account is created.

Archive Folder A Thunderbird email folder that email messages are moved to for 
long-term storage.

Archive (n.) See Archive Folder.

(v.) To move email messages to a folder for long-term storage.

Best Practice A method of doing something that is generally accepted as the best 
to use in a situation.

Children Hierarchical email folders or computer directories that are contained 
within another folder or director.

Client Connects to a server to perform tasks or access data.

Column Header A label at the top of a column of data that identifies the type of data 
in the column.

Compact A Thunderbird term for permanently removing previously deleted 
email messages from an email folder.

Computer Operating System Computer software that provides an environment and framework for 
other software programs to operate within.

Conversation A Thunderbird term for a for a series of email messages and replies 
in response to an original email message. More commonly called a 
thread.
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Conversation Tab A Thunderbird display component that shows email messages from 
a single conversation in a tab.

Custom Message Views A Thunderbird view filter that uses Search Rules to limit the email 
messages that are displayed in the Message List Pane.

Debian A version of the Linux computer operating system.

Email Account A service, and the associated logon information, provided by an 
email provider that allows a user to send and receive email 
messages, generally for a single email address.

Email Client A computer software program that accesses email services on an 
email server.

Email Provider A company that provides users with access to email services.

Email Server A software program or computer that transfers email messages 
between computers on the Internet.

Evolution A free, open-source software program that contains tools for using 
email, contacts, calendars, notes and to-do lists.

Expunge To permanently remove deleted email messages in IMAP Inboxes. 
See also Compact.

Favorite Folders View A Thunderbird email folder display method that limits the folders 
shown in the Folder Pane to only those that the user has specified.

Field Computer terminology that refers to a single piece of information in 
a group of related information. For instance, the sender's email 
address in an email message or the city in a postal address.

Filter (1) (n.) Option(s) that limit the selection of email messages.

(2) (v.) To limit the displayed email messages to only those that 
match defined Search Rules.

(3) (v.) To search for email messages that match defined Filter 
Rules and perform actions on them.

Filter Rule A Thunderbird method of searching for email messages that 
specifies where to look for, and how to match a single search 
criteria. A Message Filter is made up of one or more Filter Rules 
and associated actions, while a view filter only has Filter Rules.
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Filters Options See Global Search Filters.

Firefox Free, open-source software developed by Mozilla to allow users to 
view and interact with Internet sites.

Folder Pane The area of the main Thunderbird window that displays the email 
folders.

Global Search A text-entry box at the top of the main Thunderbird window that 
allows a user to enter terms, addresses, etc., to search for in email 
messages.

Global Search Filters A Thunderbird method of limiting the email messages displayed in 
Global Search results.

Global Search Results Tab A Thunderbird display pane that shows previews of Global Search 
results, and filters to limit which results are shown.

Gmail A web-based email service provided by Google.com.

GNU A humorous recursive acronym that stands for “GNU's Not Unix”. 
A project to develop a free alternative to the UNIX computer 
operating system.

GPL See GNU Public License.

GNU Public License The most widely used free software license.

Graphical User Interface Computer software that allows a user to interact with a computer 
operating system in a graphical, as opposed to text-based, manner.

Groupware Computer software that allows collaborative work by multiple users.

GUI See Graphical User Interface.

IMAP See Internet Message Access Protocol.

Index File A special Thunderbird file that identifies where in an email folder's 
text file an email message is located.

Interface A computer hardware device or software that allows a user to 
communicate with the computer.
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Internet Message Access 
Protocol

A communication language used by email servers and clients to 
transfer email messages over the Internet.

Junk A Thunderbird indicator that an email message is junk mail.

Junk Mail Email messages that are unsolicited and/or unwanted. Often called 
spam.

Junk Mail Bar The part of a Thunderbird Message Pane that indicates an email 
message has been marked as Junk. See also Junk Mail.

Junk Mail Controls Thunderbird tools to automatically identify junk mail and perform 
actions on it. See also Junk.

Junk Status A Thunderbird indicator of whether an email messages has been 
marked as Junk. The junk status of an email message can be shown 
in a column in the Message List Pane. See also Junk Mail and 
Status.

KB Kilobyte

Launchpad An internet site, launchpad.net, that provides a suite of tools that 
allow people to communicate about computer software.

Linux A computer operating system developed by Linus Torvalds, based 
on UNIX and available for free under the GPL.

Local Folders A group of Thunderbird email folders that store messages on the 
local computer's hard drive and are not associated with an email  
account.

Log A list of actions performed.

Macintosh A personal computer and computer operating system manufactured 
by Apple Inc.

Mail Views List A Thunderbird view filter that limits the email messages displayed 
using Filter Rules.

Mark To set the status or junk status of an email message.

Message Filter A Thunderbird tool to find email messages using Filter Rules and 
automatically perform actions on them.
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Message Header (1) The part of the Thunderbird Message Pane that displays an 
email message's sender, recipients, subject, date, etc.

(2) Information about an email message used by email servers to 
send email messages.

Message List Pane The part of the main Thunderbird window that displays a list of 
email messages and information about them in columns.

Message Pane The part of the main Thunderbird window that displays an email 
message and its Message Header.

Message Priority An indicator set by the sender of an email message that specifies 
how importantly the message is. The message priority of received 
email messages can also be changed by Thunderbird Message 
Filters.

Mozilla A computer software developer that produces non-profit Internet 
software. Officially known as the Mozilla Foundation.

Mozilla Messaging The division of the Mozilla Foundation that is responsible for the 
development of the Thunderbird email client.

Newsgroup And Internet forum on the Usenet service containing messages 
discussing various topics.

Open-source Computer terminology for software that provides access to its 
programming “source code” and is licensed to allow modification 
and redistribution.

Order Received A number set by Thunderbird that indicates the order that email 
messages were received by an account. On some versions of 
Thunderbird this number that might not be consecutive as they are 
based on the email message size added to the previous Order 
Received number.

Parent A hierarchical email folder or computer directory that contains 
subfolders or directories. See also Root.

POP Informal slang referring to downloading email from a POP3 email 
server. See also Post Office Protocol version 3

POP3 See Post Office Protocol version 3
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Post Office Protocol version 3 A communication language used by email servers and clients to 
transfer email messages over the Internet.

Priority See Message Priority

Profile A Thunderbird term for all the email account information and 
associated email messages that Thunderbird holds. This information 
is stored in a hidden folder, called “.thunderbird”, in the user's 
Ubuntu “Home Folder”, 

Quick Filter A Thunderbird tool to quickly limit which email messages are 
displayed in the Message List Pane.

Quick Filter Icons Icons on the Quick Filter toolbar that quickly limit the email 
messages displayed in the Message List Pane to messages that; 
haven't been read, have Stars, are from contacts in your Address 
Book, have Tags, or have attachments.

Recent Folders View A Thunderbird email folder display method that limits the folders 
shown in the Folder Pane to only those that the user has viewed 
recently.

Retention Policies A Thunderbird setting that automatically deletes email messages 
based on their age, or the number of messages in an folder or 
account.

Root (1) A hierarchical folder or computer directory that contains all the 
other folders or directories.

(2) The administrative user on a UNIX/Linux based computer.

Rule See Filter Rule.

Saved Search Folder A special Thunderbird email folder that continuously collects email 
messages matching a set of Filter Rules.

Search Criteria The part of a Filter Rule that specifies what the rule must match, or 
not match, in an email message.

Search Messages Tool A Thunderbird tool that uses Filter Rules to find and display email 
messages.

Search Rule See Filter Rule.
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Server A computer software program or computer that answers requests 
from a client.

Snail Mail A slang term that refers to physical postal service mail.

Spam See Junk Mail.

SpamAssassin A junk mail filtering product. SpamAssasin is not part of 
Thunderbird, but can used to help determine if an email message is 
junk mail.

SpamPal A junk mail filtering product. SpamPal is not part of Thunderbird, 
but can used to help determine if an email message is junk mail.

Star (1) A method that Thunderbird and Gmail use to indicate important 
email messages.

(2) An indicator on the Message Header of an email message that 
shows if an email address is in Thunderbird's Address Book.

Status Indicates if an email message has been read, is new, has been replied 
to, or has been forwarded. See also Junk Status.

Tag Priority The order a Tag shows up in Thunderbird's lists of Tags. 
Thunderbird's default Tags have the highest priority, followed by 
user-created Tags in alphabetical order.

Tag A Thunderbird method of categorizing email messages with colours 
in the Message List Pane, and labels in an email message's 
Message Header.

Thread See Conversation.

Thread View A Thunderbird method of grouping email messages in the Message 
List Pane by conversation.

Thunderbird Free, open-source software developed by the Mozilla Foundation to 
receive, view, respond to and compose email or newsgroup 
messages.

Ubuntu (1) A free, open-source computer operating system based on Debian 
GNU/Unix.

(2) The Southern African Bantu word for an ethical ideology that 
promotes humanity towards others. 
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Ubuntu Vancouver Local 
Community

A computer users group in Vancouver, Canada, focusing on the 
Ubuntu Linux computer operating system.

Ubuntu Vancouver LoCo See Ubuntu Vancouver Local Community.

Unified Folders View A Thunderbird email folder view that groups email folders based on 
the type of folder they are, regardless of their email account. For 
instance, the Inboxes of all email accounts will be grouped under a 
parent folder called Inbox. Inbox, Drafts, Sent, Archives, Junk and 
Trash folders are all grouped when Unified Folders are being 
displayed.

UNIX A trademark for a computer operating system, developed in 1969 at 
the AT&T Bell Laboratories, that can be used by more than one 
person at a time.

Unread Folders View A Thunderbird email folder view that displays only folders that 
contain unread email messages.

USB Flash Drive A device that can be plugged into a computer that uses solid-state 
(no moving parts) memory to store data. Also called, key drive, pen 
drive, or thumb drive.

Usenet An Internet communication system that transmits news and 
discussions.

UVLC See Ubuntu Vancouver Local Community

Vacation Response An automatic reply to received email messages. Often used to notify 
senders that the recipient is on holidays and they will reply when 
they return.

View Filters A Thunderbird method of limiting the email messages displayed in 
the Message List Pane. See also Global Search and Quick Filter.

Webmail An Internet-based service that allows users to receive, view, respond 
to and compose email messages using a Web browser.
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